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Office Medic Settings

These are Office Medic settings that are important for the user to know.

1. Options > Spirometry... > General > Spirometry Standard
This setting allows the user to configure which Spirometry Standard to use.

General Environmental Prnting Predictors Optional Parameters
Incentive

Graph with predicted effort

Interpretation Spirometry Standard

’ Narrative Interpretation o ATSJERS (2019)
O ATS/ERS (2005) B () ATS/ERS (2005)
(_) BTS-NICE (2004-05) () BTS-NICE (2004-05)
() NLHEP (2000)

() Enright (1987) Units
- () Usec
_Lung Age O Limin
[__JHome Use{Saves mouthpiece number for subsequent use ) Restore Defaults

OK Cancel

2. Options > Spirometry... > Predictors

This setting allows the user to configure which predictors to use for FVC, SVC and
MVV.

General Environmental Printing Predictors Optional Parameters

FVC/SVC Predictors MWV Predictors Refer to User's Manual for race corrections,
Adult First Choice Adult Predictor
GLI-G (Race-Neutral) Cherniack '72

Adult Second Choice

Pediatric Predictor
GLI2012

Zapletal '87
Pediatric First Choice
Seftings
GLI-G (Race-Neutral)
ifthe subjectis >= 18 years old. use the Adult predictor equation
Pediatric Second Choice
GLI2012 If a predicted equation does notinclude race comections use

0 % for Black Subjects

0 % for Asian subjects

Restore Defaults

OK Cancel
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Performing a Spirometry Test for the First Time (using ATS 2019 Standards)

1. Connect the Orbit Spirometer to the desktop, laptop, or tablet via the USB cable.

2. Launch Office Medic. When Office Medic opens, the screen below appears:

"4 Office Medic - Local SQL Server dotabase: - o x

File Test Options Taols Hel

3. Create a new patient by clicking the “New Patient” icon or by clicking “File” > “New”.

g Office Medic - Local SQL Server database

Test Options Tools Help

Blwme @ qa > | @

[#- Calibration Data
F-,, 123TEST

4. Enterin all known patient information (mandatory patient information is denoted
with an asterisk) and click “OK”.

Patient Information X
LastName” FirstName” Account # D#
Doe John 123ABC 123ABC
Address Phone Mumber
123 Main Street 123-456-7890
Height(cm)* Weight(kg)  Gender” Race” *Required
123 123 Male ~ Notlisted ~
0K
Birth Date * Age Smoking-Pack Years

3241950 [ 76 yr Cancel
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5. The newly created patient will now appear in the main patient trunk database.
Highlight the patient and click the “Spirometry” button or click “Test” >
“Spirometry...” to start a spirometry session.

3! Office Medic - Local SOL Server database

File Options Tools Help
0 ; = . -
N ®qelhl. @

t- Calibration Data
+-,, 123TEST

it Doe, John, 123ABC

t-TEST, TEST, 213

6. The user will be taken to the screen below. Click on the type of spirometry test the
user would like to perform. (Pre FVC, Pre MVV, Pre SVC).
In this How-To-Guide, FVC tests will be chosen.

Perform Test

PIRFVC | PraMW | PraSVC

PrevTest| NexiTest  lnterp  Print  Delote

7. The user must enter in the mouthpiece serial number (8-digit number located on the
white plastic mouthpiece). Click “OK” to begin the test maneuver.

r Pre FVC Test

Mouthpiece &

Physician/Tech

Ensure the patient does not cover or obstruct the mouthpiece fabric during testing
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8. The user will begin to see flashing red and yellow lights which indicate that the
device is zeroing. Make sure the user does not have the mouthpiece in their mouth
or cause any disturbances to the device/pressure tube/mouthpiece as this can
prolong the zeroing phase.

Unit zeroing- Please wat.

9. Once the device has successfully zeroed, both of the lights will turn green which
indicates that the test can begin. Instruct and encourage the patient to perform the
spirometry test to the best of their ability. (i.e. For a FVC Test, the user should take a
deep breath and then forcefully and completely exhale much as possible into the

mouthpiece)

Perform Test
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10. Once the test has concluded, the user will be taken to the screen below.
If the user agrees with the acceptability and usability criteria, they may click “Yes”.
If the user disagrees with the acceptability and usability criteria, they may click “No
(Edit)” to configure which criteria are designated as met.

Volume()

8 [ Flow (iis)

ﬁ_g\\.
e N

N
_&_ T2 3 4 5 6 1 8
- 2 4 6 8 i0 12 415
Volumel)
2 Time(s)
5 —
4 N
5 8 =
00:07 Approve results below? Yes N Gy First Test Recorded: Provisionally Meets EOFE Criteria

FVC Acceptabilty  (7) Acceptable @)
(?) Usable
(?) NotUsable

FEV1 Acceptability (?) Acceplable

() Usable

(7) NotUsable

7 Acceptability and Usability Criteria for FVC and FEV1: Verification Required
Technician Verfied Acceptabilty Crteria "Defaultsetto eriteiia metby the syster"

System-Validated Acceptabiliy Criteria
@)  Musthave BEV <=5% of FVC or 0.100L whicheveris greater

@D Musthave no evidence of a faulty zero-flow setiing

@) Mustachieve one of the three EOFE indicators

@ Musthave FIVG - FVC < 0.100L or 5% of FVC. which s greater,
ifthe maximal inspiration after EOFE is greater than FVC

Repeattests recommendad for confirmation
®

-

Musthave no cough in the first second of expiration. For children aged 6 years or younger must have afleast
[ o ptable of usable EVD75

-

aaaaa

) Musthave no glofic closure afler 15 of expiration

A

) Musthave P

A

) Musthave no evidence ofa leak

11. Once approving the acceptability and usability criteria results, the user will be taken

to the screen below. The user will be able to review the volume graphs, z-scores,

pre-test session grade and the measured values.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM X
Peiform Test ion Comments _ Calibration Check S n D

Pre FVC PreMVV PreSVC PostFVC Pre TestSession Grade' FEV1 - EFVC - E
PreTUC a1 1108 AM (Best) FVC FEV] [}
Parameter Pred LLN Z-Score Result % Pred.
FVC (L) 188(Gg) 147 846 405  2159% Volume(l) 11 Flow (is)
FEV1 (L) 1.75 (Gg) 1.37 8.29 347 197.8% -~
FEVAFVC 092(Gg) 080 094 086 93.1% 5
FEVS (L) 405 7
FEVAIFEVS 0.86
FEVO.5 (L) 2.56 4
FEV3 (L) 4.05 7
FEVIIFVC 1.00
PEFR (Limin) 365.16 L
PEFT (s) 0.10 3 0 ey ]
FEF25% (L/min) 32382 2 6 8 10
FEF50% (L/min) 278.52
FEF75% (L/min) 141,60 2 wolume)
FEF25-75% (Limin) 232.86
FIVC (L) 3.95
FIVO5 (L) 181 1 2
FIV1 (L) 392
FIV3 (L) 3.95
FIVIIFIVC 088 1 1 1 J
FIVIFIVC 1.00 1 2 4 5 6 -1
PIFR (Limin) 293.76
FIF50% (L/min) 280.14
FIF25-75% (Limin) 282.24 Time(s)
FIF.2-1.2 (LImin) 249.42 2 i
FVCIFIVC 103 Z-Score Pictogram
E LLN Pred. ULN

xt. Vol. (L) 0.04 —
FET(s) 2.40 Fve
EOTV (L) 0.10 FEVI -_—

FEVUFVC NI |
5 4 -3 2 -1 0 1 2 3 45

PrevTest MNextTest Interp Prnt = Delete

End Session Cancel
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12. According to ATS 2019 Spirometry Standards, it is recommended to perform a
minimum of three test maneuvers for both pre and post-test sessions. Click “Pre
FVC” to perform additional pre-test maneuvers.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM

Perform Test Session Comments Calibration Check Session Demographics
PreMVV PreSVC PostFVC

e rv 13AM  -28% Best FVC FEV1 “
Parameter Pred. LLN Z-Score Result % Pred.
FVC (L) 188(Gg) 147 8.6 398 211.8%
FEV1 (L) 175(Gg) 137  7.60 334 190.2%
FEV1/FVC 0.92 (Gg) 0.80 -1.17 0.84 91.3%
FEV6 (L) 3.98
FEV1/IFEVE 0.84
FEV0.5 (L) 249
FEV3 (L) 3.98
FEV3/FVC 1.00
PEFR (L/min) 366.00
PEFT (s) 0.08
FEF25% (L/min) 338.64
FEF50% (L/min) 263.82
FEF75% (L/min) 101.88
FEF25-75% (L/min) 212.76
FIVC (L) 379
FIV0.5 (L) 1.54
FIV1 (L) 345
FIV3 (L) 3.79
FIVIIFIVC 0.91
FIV3/FIVC 1.00
PIFR (L/min) 255.60
FIF50% (L/min) 22464
FIF25-75% (L/min) 235.38
FIF.2-1.2 (L/min) 22422
FVCIFIVC 1.05
Ext. Vol. (L) 0.03
FET (s) 299
EOTV (L) 0.05

13. After performing additional pre-test maneuvers, the user will observe that there is
now a percentage variability reported.
When there are more than two pre-test maneuvers performed, the variability will be
calculated from two of the best pre-test maneuvers.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM x
Perform Test  Session Comments Calibration Check  Session Demographics

PreFVC  PreMVW PraSVC  PostFVC M Ipm TestSession Grade: FEV1 - B. FVC - B (FVC Var=0.08L (196%). FEV1 Var=0.13L (398%)) I
Pre FVC#21113AM  -28% Best FVC FEV1 “
Parameter Pred. LLN Z-Score Result % Pred. _
FVC (L) 188(Cg) 147 816 398  211.8% Volume(l) 1 [ Flow(is)
FEV1 (L) 1.75(Gg) 137  7.60 334 190.2% B C
FEVAIFVE 092(Gg) 080 147 084  91.3% 5 L
FEVE (L) 398 7r
FEVAIFEVE 084
FEVO0.5 (L) 249 4
FEV3 (L) 398 r
FEV3IFVC 1.00 -
PEFR (L/min) 366.00 3l L
PEFT (s) 0.08 0 S
FEF25% (Limin) 338.64 2 b 8 10
FEF50% (L/min) 263.82
FEF75% (Limin) 10188 2r r Volume()
FEF25-75% (Limin) 21276 C
FIVC (L) 379 L
FIV0.5 (L) 1.54 1 5 -
FIV1 (L) 345 -
FIV3 (L) 379 -
FIV1IFIVC 081 1 1 L 1 1 1 i B
FIVIFIVC 1.00 1T 2 3 a4 5 & 1 -
PIFR (L/min) 255.80
FIF50% (Limin) 22484
FIF28-78% (Limin) 235.38 Time(s)
FIF.2-1.2 {Limin) 22422 2 i
FVEIFIVE 108 Z-Score Pictogram
Ext. Vi LLN Pred. ULN

o byt _—
FET(s) 289 Fve
EOTV (L) 0.05 FEV1 |

FEVIIFYC || |

PrevTest NextTest Interp  Print Delete O ow o A WU dEdd g

End Session Cancel



VECTRACOR

Diagnosing Better Care

AVecTrRACOR COMPANY

14. After performing a minimum of three pre-test maneuvers and establishing an
average baseline value, the user can perform post-test maneuvers as necessary.
Post test maneuvers are commonly used to observe the effectiveness of
medications such as bronchodilators. Click “Post FVC” to begin a post-test session.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM

Perform Test Session Comments Calibration Check Session Demographics
PreFVC PreMVV  Pre SVC | PostFVC

Pre FVC#211.13AM  -28% Best FVC FEV1 “
Parameter Pred. LLN 2Z-Score Result % Pred.
FVC (L) 1.88 (Gg) 1.47 8.16 3.98 211.8%
FEV1 (L) 1.75 (Gg) 1.37 7.60 3.34 190.2%
FEV1/IFVC 0.92 (Gg) 0.80 -1.17 0.84 91.3%
FEVS (L) 3.98

FEV1/FEVE 0.84

FEV0.5 (L) 249

FEV3 (L) 3.98

FEV3IFVC 1.00

PEFR (L/min) 366.00

PEFT (s) 0.08

FEF25% (L/min) 338.64

FEF50% (L/min) 263.82

FEF75% (L/min) 101.88

FEF25-75% (L/min) 212.76

FIVC (L) 3.79

FIV0.5 (L) 1.54

FIV1 (L) 345

FIV3 (L) 3.79

FIVIFIVC 0.91

FIV3IFIVC 1.00

PIFR (L/min) 255.60

FIF50% (L/min) 22464

FIF25-76% (L/imin) 235.38

FIF.2-1.2 (Limin) 224.22

FVCIFIVC 1.05

Ext. Vol. (L) 0.03

FET(s) 2.99

EOTV(L) 0.05

15. After performing the first post-test maneuver, the user will observe that there are
new measurements: % change, % BDR and a post-test session grade.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM X

Perform Test Session Comments Calibration Check Session Demographics

PostFVC -
PostFVC #1 1159 AM Best) Ve o IDDS\T.ElSes!\Dn Grade: FEV1 - EFVC - E l

Pred. LLN Z-Score Result % Pred. | % Change % BDR
5 Volume(l) n

1.88 (Gg) 147 8.15 397 21.6% =0 a
1.75 (Gg) 137 7.70 336 191.3% -3.3%  63%
092(Gg) 080 -1.09 084 91.9% -1.3% -1.1% 5

Var=0.08L (1.96%). FEV1 Var=0.13L (398%))

Flow (lis)

397 -20% .
084 -13%
238 7.1% Ak
37 20%
100 00%
35208 -36% e
007 -250% q
32088 0.5%
22806 -18.1%
12658 12.5% 2
)l 2138 -0.2%
396 02%
170 8.1% 1 =
81 9%
336 03%
091 -8.2% 1 | 1 — L ]
J00 ot 12 3 4 5 6 71 -
25398 -13.5%
23480 -16.3%
) 23544 -16.6% Time(s)
2321.9:° -625;; Z-Score Pictogram
003 6% LLN Pred. ULN
X 5 0% FVC [
276 15.0%
008 -28.2% FEvi —
|

FEVIIFVC |
5 -4 3 2 a1 0 1 2 3 4 4

8 10
Volumefl)

PrevTest NextTest Interp Prnt  Delete

End Session Cancel



VECTRACOR

Diagnosing Better Care

AVecTrRACOR COMPANY

16. According to ATS 2019 Spirometry Standards, it is recommended to perform a
minimum of three test maneuvers for both pre and post-test sessions. Perform
additional post-test maneuvers by clicking “Post FVC.”

Spirometry Test Session 3/25/2026 11:08 AM

Perform Test  Session Comments alb@ation Check Session Demographics
M PostFVC A
Post FVC #2 1202 PM (Best) v FEVI “

Pred. LLN 2Z-Score Result % Pred. % Change % BDR

1.88 (Gg) 147 9.07 421 224.4% 3.9% 8.5%

1.75 (Gg) 1.37 8.80 3.57 203.5% 2.9% 5.7%

0.92 (Gg) 080 -1.06 085 921% -1.14% -1.1%
421 3.9%

085 -1.1%
264 3.2%
421 3.9%
100 0.0%
38994 6.8%
011 16.7%
368.40 13.8%
267.60 -3.9%
11664 4.5%
1) 23484 0.9%
396 0.1%
183 -15.1%
349 -11.0%
395 -0.1%
088 -11.1%
100 -0.2%

240.84 -18.0%

22932 -18.1%

) 23142 -18.0%
20112 -19.4%

106 3.8%

0.10 188.6%

259 8.0%

0.09 -11.1%

17. After performing additional post-test maneuvers, the user will observe that there is
now a percentage variability reported.
When there are more than two post-test maneuvers performed, the variability will
be calculated from two of the best post-test maneuvers.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM x

Perform Test Session Comments Calibration Check Session Demagraphics

F PostFVC v Pre Test Session Grade: FEV1 - B.FVC - B (EMC a0 081 (19620 EEVI Vam 131 (3935,
PostFVC #2 1202 PM (Best) Ve eVt o Post Test Session Grade: FEV1 - D.FVC I:IcFVCVav-MAL (609%). FEV1 Var=0 21L (6 34%.;3'
Pred. LLN Z-Score Result % Pred. % Change % BDR
1.88 (Gg) 147 9.07 421 2244%  3.9%  8.5% Volume()) 11 Flow (iis)
175(Gg) 137 880 357 2035%  29% 57% 7
0.92 (Gg) 080  -1.06 085 921% -1.1% -11% 5
421 39% 7
085 -1.1%
284 32%
a1 39%
100  0.0%
38994 6.8%
01 16.7% 0 {Hclw{'lll‘{
36840  13.58% 2 4 6 8 10
267.60 -38%
11684  4.5% Volume(l)
1) 21484 0.9%
396 0.1%
153 -15.4% P
349 -11.0%
385 01%
088 11.1% )
100 -0.2% 8 11
24084 -1B.0%
22932 -18.4%
] 23142 -18.0% Time(s)
2("1‘1:5 ":';;f Z-Score Pictogram
010 188.6% LLN Pred. ULN
259 B.0% FVG [
008 -11.1% FEV1 —
FEVIFVC EEEEEL |
Prev Test  Next Test Interp ~ Print Delete 5 4 3 2 1 0 ! 2 3 4 5

End Session Cancel
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18. Add comments as necessary. Type in freeform text or choose from a list of
predetermined operator comments.

Doe, John Spirometry Test Session 3/25/2026 11:08 AM

Session Comments Page

@ operator comments 0/660
Relating to Patient condition
[ Mo comments
[~ First attempt at spirometry
™ Reference values are based on ethnicity that may not be suitable for this patient
[~ Patient used bronchodilator(s) prior to test
[~ Patient smoked < 1 hr prior to test
[~ Patient had difficulty understanding directions
[ Patient reported consumption of an intoxicant
[~ Observed symptoms e g cough, Observed symptoms e.q cough, wheeze, dyspnea o cyanosis
Relating to bronchodilator responsiveness testing
[~ Facility bronchodilator responsiveness protocol followed for type, dose and delivery method of bronchodilator and wait time before post-BD testing
[~ Post-BD measurements obtained using other bronchodilator(s), dose(s), delivery method or wait time
Relating to quality of testing session
[~ No comments
[~ Acceptability and/or repeatability criteria not met despite patient's best efforts
[ Spirometrv induced bronchosoasm

19. Click “Print” to print to a physical printer (Name: Your Printer Here) or to generate a
PDF (Name: PDF Writer — bioPDF).

Prev Test Next Tesi Interp m Dielete

Print

Printer

Name HP5F9414 (HP OfficeJet Pro 9010 series) - Properies

Status Ready
Type HP OfficeJet Pro 9010 series PCL-3
Where hitp //[fe80: €270 eafffe5£9415%19).3911/

ST, () Printto file
Print range Copies
Ol Number of copies 1 =
Pages ) 0
() Selection 1,2‘3‘ 1,2'3

OK Cancel
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20. Click “End Session” to conclude the spirometry session and return to the main
screen.
Time(s)
Z-Score Pictogram
FVC |
FEVI [
FEviFve R |
5 4 -3 2 10 1 2 3 4 5

I End Session I Cancel

LLN Pred. ULN

*For more information on performing a spirometry test, please visit the following website:
https://www.vectracor.com/educational-training-videos/ & consult the user manual for

more detailed information.


https://www.vectracor.com/educational-training-videos/

